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3.10  Turning the Phone On and Off
You can turn your phone on and off while keeping your actual device On. Your phone is off when it is in
flight mode.

1. Tap the signal icon ] on the navigation bar.

2. To turn the phone off, tap Turn on flight mode.
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3. To turn the phone on, tap Turn off flight mode.
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4.1  Adding a New Contact

Besides using Contacts in Pocket Outlook to manage the contact information stored in the Pocket PC
Phone, you can also use the Caller ID program to add new contacts.

@} *  You cannot use Caller ID to manage the contact information stored in the SIM card. You need

to first use the SIM Manager program to save the contact information to Contacts in Pocket
Outlook.

1. Tap A% — Programs — CallerID. 7 [T —
2. By default, the screen displays all contacts stored in Contacts. Search name

The bottom of the screen displays the current caller picture
preview of the selected contact, the picture filename and ring
tone file name.

3. To add a new contact, tap New on the command bar.

@ Select picture
. Select ringtone

New Edit View Tool E|A

4. Enter the name and other contact information. You will need to
hide the Input panel to see all available fields.

I 2l contacts & T« 115 (@
Name: David Wang b
Job title:
Department:
Company: =
Work tel:
Wark fax:
Work addr: o
E-mail:

Caller ID

Mobile tel:
Web page:
Office loc:
Home tel:
Home addr: 7 i
Detaits  Hotes |
Edit E|A

5. You can assign a contact to a category so that you can use these groupings to quickly display only the
information you want.
Tap Categories. On the Select tab, select the categories that you want to assign the contact to.
To create a new category, tap Add/Delete, enter the category name, and then tap Add. The new
category is automatically selected in the Select tab.
Tap OK to return to the previous screen.

6. Tap Notes. You can add written or typed notes and even recordings to a contact. For information on
Notes, see Section 8.4.
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7.

Tap OK to return to the contact list. The new contact is
added to the list.

4.2  Setting a Caller Ring Tone

A

E) caller D[1/2] 3T )
Search name

#ab| cde| fgh| ik | Imn|opg| rst uve) syz

[ fian 23
WangDavid 1234567899

@ Select picture
. Select ringtone

New Edit View Tool E|A

‘@' *  The sound formats supported by the Pocket PC Phone include: Polyphonic, Monophonic,
’ MIDI, AMR, WAV, MP3 and WMA.

Assigning a Ring Tone

1.
2.
3.

Tap ## — Programs — CallerID.

Select the contact to assign a ring tone.

Tap the music note icon at the lower right of the screen.
You can also tap Edit — Select picture.

Tap the arrow next to RING list to display the sound files
on the Pocket PC Phone, and select the desired file. You
can tap the Playback button for playback, and tap the Stop
button to stop playback.

Make sure that you have selected the RING item, and then
tap OK.

The selected sound file is displayed on the screen.

[z caller D[1/2] 23 V| 4% 11:16 (D

Picture name

T a—

Display

RING -1
default
SymphoniesNO.40.mij

@ Select picture
. SymphoriesNO.40.

New Edit View Tool E|A

al Je11eo
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Canceling the Ring Tone Setting

1.

2.
3.
4

Tap &% — Programs — CallerID.

Select the contact to cancel a ring tone.

Tap the music note icon at the lower right of the screen.
Clear the RING item, and then tap OK.

4.3  Setting a Caller Picture

GIFF and 3GP.

Assigning a Picture

1.
2.
3.

Tap 4% — Programs — CallerID.
Select the contact to assign a picture.
Tap the picture icon at the lower right of the screen.

You can also tap Edit — Select picture.

Tap the [ ] icon next to Picture name to browse the pictures on
the Pocket PC Phone.

In Search, select the storage location of pictures; in File type,
select the file type of pictures. Then tap Search.

Fiilcaller o1/2) & V)| ¢ 1217

Picture name

T —

Display

O Eroomesoo~] 5]

=8

e The picture formats supported by the Pocket PC Phone include: JPEG, PNG, BMP, GIF, MPEG4,

Fllcaller /2] 2 V)| ¢ 1217 @

Picture name

[ —

Display

e oo+ [

Fiilcaller o1/2] & V)| ¢ 1118 @

File tyee e -] [cancel

Flename | Date [ Fies... | Path

4] [} T

Fllename
File info File type
File time File size
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8.

A picture list appears on the screen. Select the desired picture
file, and tap OK.

The preview of the selected picture appears at the upper-left of
the screen with its filename on the right.Tap OK.

The selected picture file is displayed at the lower-left of the
screen, and its filename is displayed on the right.

Canceling the Picture Setting

1.

2
3.
4

Tap #¥ — Programs — CallerID.
Select the contact to assign a picture.
Tap Edit — Delete selected picture.

Tap Yes to confirm.

"ol caller ID[1/2] § V)| 4% 11:18
il

. Picture name
sl oo oo )]

Display

R Bromeon~] 5

=R

Fl]caller [1/2] 23 | 4% 11:18 €3
Search name

al Je11eo
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4.4  Managing Contacts

Editing a Contact

1. Tap ## — Programs — CallerID.

2. Select the contact to edit, and tap Edit — Edit.
3. Make the changes and tap OK.

Deleting a Contact

1. Tap & — Programs — CallerID.

2. Select the contact to delete, and tap Edit — Delete.
3. Tap Yes to confirm.

View Modes

Caller ID provides four view modes for displaying the contact
information.

B Index label

B Preview

B Details

B Display contact name only

By default, the index label appears at the top of the screen for you to
quickly access a contact. The center of the screen displays the name
and default contact number of the selected contact.

To view the detailed contact information, tap View — Details on the
contact list. Tap OK to close the details screen.

4.5 Changing Settings

I 2l contacts
Julian Messer

Pl LTS tEL K]

Mobile tel

1234567890

Delete

Select picture
Delete selected picture
Edit| View Tool

(New

caller ID[1/2] &F )| 4% 11:20
il
Messerlu...
1234567890 Mabile tel
<1 | Edit Option E|A

On the contact list screen, tap Tool — Option. You can select or clear the display of caller picture upon an

incoming call.
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5.1 Recording Messages in Notes

In any program where you can write or draw on the screen, you can also quickly capture thoughts,
reminders and phone numbers by recording a message. The recordings will be saved as .wav files in the
\My Documents folder on the Pocket PC Phone.

You can record a message when the Record button appears on the command bar. In Pocket Word, use the
recording function by the View menu.

Creating a Recording

1. Hold your Pocket PC Phone’s microphone near your mouth or FE]mote V1 6 051 €0
other source of sound. =) All Folders ~ Name +
2. Hold down the Record key. When you hear the beep, begin your ra ;::::rz:” == iﬁ:,:s
recording. Notel 12392
. ) . (] note2 1z4ia
Keep holding down the Record key during the recording. - Recording1 5L p——

4. Release the key when you are finished. You will hear two beeps.

The new recording is stored as a stand-alone recording if no note
is open. Tap the recording file to play back.

o [m] ) [—— [ m]at
New Tool -

‘@} »  The recording indicator glows in red when a recording is in process.
*  You can use the Record/Playback toolbar for recording and playback.

*  Tap #¥ — Settings — Personal — Input — Options to select the recording format.

Recording Formats

Your Pocket PC Phone supports several formats for voice notes. The formats vary in both the quality of the
recording and the size of the sound file. When selecting a recording format, you should consider the quality
you need as well as how much storage memory the recording will use on your Pocket PC Phone.

Not all recording formats are compatible with other software or computers. If you will share your record-
ings with others or transfer a recording to your desktop computer, be sure to choose a recording format that
is supported by the software used to play recordings on the other computer.

The PCM format offers the highest quality recording and is compatible with all Pocket PC Phone models,
other Windows-powered mobile devices and desktop computers that use Windows operating systems. The
GSM 6.10 format is compatible with all Pocket PC Phone models and other Windows-powered mobile
devices, but may not work with desktop computers.

To select a recording format, tap lﬂ'. — Settings — l?ersonal - Pl sectings 2 Taces @
Input — Options to select a recording format. The list of recording Input

formats on your Pocket PC Phone indicates the sample rate, whether Voun vk Foets

the format is stereo or mono and how much storage memory is 11,025 Hz, 16 Bit, Mono (22 KB/s) |

. . . . 11,025 Hz, 16 Bit, Mona (22 KBJs)

required per second of recording. You may need to experiment with TSRS KB,E}
; ; ; 22,050 Hz, 8 Bit, Mono (22 KB/s)

different sample rates and formats to determine which format best 55050 Ho. 8 Bit. Stereo (43 kBj%) ||
22,050 Hz, 16 Bit, Mono (43 KB/s) |~

suits your needs.

Scroll upen reaching the last line

Input Method | Word Completion | Cptions

=8
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52 AMR Recorder

Besides the built-in recording program described in the previous section, you can also use the AMR Recorder

program to record messages. AMR Recorder will save the recordings as AMR files in the My Device\Flash\

Recording folder on the Pocket PC Phone.

1. Tap & — Programs — AMR Recorder.

2. Hold your Pocket PC Phone’s microphone near your mouth or other source of sound. Then tap the @
icon to start recording.

FZlamr Recorder ;F 7)) 42 1057 €3
File name | Date Length | Locatior
@ BERLL.. 2005/.. 25175 \SDMM
© vester... 2005/.. 240.45  \SDMM
& ding.amr 2005/... 0.9s \My Dog
Fast backward
Playback progress — — = — Fast forward
Tap to play back —fef=fp | l———= ] [u Adjusting playback volume
Edit Tools E|-

3. To stop recording, tap the M icon. The recording will appear on the list. (To delete a recording, tap and
hold the file on the list, and then tap Delete.)

-+ The recording indicator glows in red when a recording is in process.

»  Ifthe earphone is already connected to the Pocket PC Phone, then the recording will receive
sounds from the speaker on the earphone.

You can change the following settings in AMR Recorder:

B To chnage the storage location of the recording files, tap Tools EZ]amR recorder 22 ) 4¢ 1057 @
. Storage path
— Settings. 5 LI FLAsH -
DI y Abum
ERt=T recording
CIE@ my Music
T MSMETADATA
+-L1C3 spMmec
#-CIE3 Application Data
- CJE3 connMgr
+-CJE2 Documents and Settings

=
@
(24
1]
)
Q
[}
(2]

Buipiooay

7 LI persistent Storage
7-LIE3 Favorites

-] program Files

7 CIE3 My Documents

1 LJE3 Temp

=-LIE windows =

=18

7| Settings & V)| ¢ 1058 D

Microphonet Environment Setting

B To change the recording quality, tap Tools — Microphone En- e :
. . . If you choose "Dictation” ,the distance to
vironment Setting. When finished, tap OK to save the change. collect voice wil e shortened to avoid th

mixed noise and vice verse, to balabce the]
recording quality.

Q Auto

(® Dictation (Short distance)|

() Meeting (Long distance)

Edit Tools E‘.
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Customizing Your Pocket PC
Phone

6.1 Changing Personal Settings
6.2 Changing System Settings
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6.1 Changing Personal Settings

Tap 4# — Settings — Personal.

% Today

Tap Appearance to select a desired theme for the background. You Filsettngs 1 5 4¢ 1059
can also tap Beam to exchange favorite themes with your friends. Today
Tap Items to select the information you want displayed on the Today 5;;: b —
screen. You can also select a period of time (4 hours by default) for Bumng =

: Mediterranea =3
your Pocket PC Phone to automatically return to the Today screen. nsu\t

[ use this picture as the background

Appearance | Items
=8

Menus

This item allows you to customize what appears on the Start menu.
On the program list, the selected items will appear on the Start Checker iteres appear in the Start meru.

menu, and the unselected items appear in Programs. Q= sppeenn Prope
CJ@ Activesync B
You can also select the displayed items when tapping New on the Off Caleulator
[VITE Calendar =
Today screen. = contacts
]2 File Explorer
[g»Find
i Games
[y Balstorm
O Jawbreaker
[ solitaire [~

Start Menu | New Menu

£ il settings Fadh AL ESTE 0]

Menus

B_ Buttons

This item assigns programs to the hardware buttons and set the repeat rate of the Up/Down direction keys.

[z settings Padh AL EREE 0ol [/z] settings & V) ¢ 106 D E)U Q
Buttons Buttons % g
[}
1. Select a button: Customize the way your Up/Down control = 3
Assignment - ) B N
T Delay before first repeat: o a
MediaContent Short :U:. Long g
¢ Button 3 IEFavorite e ! o E)<
[=]Button 4 Contacts Repeat rate: 8 c
B Button 5 record Slow .=U=. Fast
2. Assign a program:
|<Todav> v|
Program Buttons | UpfDown cuntm|| Program Buttons | Up/Down Control
=R =R
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TR, Password

This item allows you to set a password for security. Fllsettings &t T4 11:16 (@

Password

ot i device unused
or

Tap 4¥ — Settings — Personal — Password.

2. Check the Prompt if device unused item and select a value to

i :[smole 4 digt -]
set the time for the Pocket PC Phone to prompt for password Foe st O M|
after idling. e

3. Select the type of password you would like to use. You can
set a four-digit password or a long password containing
a combination of at least seven characters, numbers or

punctuation.

4. Tap the numbers or characters to set your password. o [RE]D
To keep a hint for yourself in case you forget your password, tap =R
Prompt and enter the prompt for password.

6. Tap OK.

E::] Owner Information

o . . /54 settings 2T @
This item allows you to enter your personal information.

Owner Information

Name:

Company:
Address:

Telephone:

E-mail:

Identification | Notes | Gptions

=R

=~ Sounds & Notifications

5Q This item sets the conditions and types of the sounds, system volume and methods of notifications.
S o
> c
?g F o settings & T 122 F 4 settings & T 122 D
N a Sounds & Notifications Sounds & Notifications
E - Enable sounds for %
Q Q Events (warnings, system events) Event:
i ] e [ P sound
O Notifications (alarms, reminders) lI‘ lz‘
[] sereen taps
() Soft @ Loud
[ Hardware buttons
(Orsoft (@) Loud [ vibrate

Sounds | Notifications Sounds | Notifications
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B Input

This item sets up items related to Block Recognizer, soft keyboard, Letter Recognize, Transcriber input
methods and voice recording format.

[/l settings | 44 11:23 (D F /2 settings wfh AL FREET oL [/5] settings
Input Input Input
Input method: Suggest words when entering text Voice recording format:
(7 Large keys (@) Small keys Suggest after entering letter(s)
Use gestures for the following keys: St [T |k
[ space m SRy, Add a space after suggested word
o] Backspace @ Enter Replace text as you type Capitalize first letter of sentence
Scroll upon reaching the last line
Input Method | Word Completion | Options Input Method  Word Completion [ Options | Input Method | Word Completion | Options
=R =R =B
Q Phone
This item changes the phone-related settings. See Section 3.8 for ] settings Y42 1100 @
detailed information. e
Sounds
Ring type: -
woston: [mpraneno 0~ B8]
o
Security
D Require FIN when phone is used

Change PIN

Phone | Services | Metwork | More ‘

=B
6.2 Changing System Settings m——
o
Tap 4% — Settings — System. 2 %
=3
@j Ring Tone ol
e
This item sets the ring tone file. The screen displays all sound files P start %46 1125 @ § P
stored on the Pocket PC Phone with the format of AMR ( .awb), s il oS
MIDI (.rmi, .mmf, .mid), MP3, WAV, and WMA.
*.mid hd
Name | Date [ sze

D

[IBachs... 04/21/05 141.51

[IBeetho... 04/21/05 90.30 K
[Beetho... 04/21/05 20.81 K§
[Jpance ... 04/21/05 20.42 K§
[Debuss... 04/21/05 27.29 KH
[linthe.. 04/21/05 37.54kH
[Mozart'... 04/21/05 17.71 K§—

|_|| 6. MID 04/21/05 WA‘D‘KPV
E] ] 3
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0 Regional Settings

This item specifies the region of your location and the formats of the
number, currency, time and date.

[/ settings & Y 21126 @

Regional Settings

Appearance samples
Positive numbers: 123,456,789.00
Positive currency: $123,456,789.00

Time: 11:26:25 PM
Short date: 6/24f05
Long date: Friday, June 24, 2005

Regiun| Nllnbar| Currency‘ 'I'me| Date‘

E‘A

B, Backignt

This item adjusts the brightness of the display and sets the automatic turnoff for power saving purposes.

/2 settings & 441126 (D /2] settings Padh AL ESSET ok
Backlight Backlight
Warning: Using backlight while on battery ‘Warning:
power will substantially reduce battery life. Using backlight while on battery power
wil substantially reduce battery life.
Turn off backlight if =
device is not used for Battery
Tumcnback]ightwhenabuttonis e T EE
pressed or the screen is tapped ? : .)
AC Power
O
A
? {1 ¥
Battery Power | External Pwﬂar| BrigM:nB| Battery Power | External Pwﬂar| Brightness |—
Adijust power settings to conserve power. Adjust power settings to conserve power.
B B

Certificates

You may add/delete the public key certificates to/from your Pocket PC Phone. These certificates help
establish your identity when you are logging into a secured network, such as a corporate network.
Certificates also help establish the identity of other computers, such as servers, with which you
connect. This helps prevent unauthorized users from accessing your Pocket PC and information.

You can store two types of certificates on your Pocket PC: Personal Certificates that establish your
identity, and Root Certificates that establish the identity of servers with which you connect.
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